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AudioBooks & eBooks  

 
Audiobooks are read to you by a recorded actor. 
eBooks allow you to download the book,  magnify 
the type size and have the computer read to you 
out loud. 
 
Free Online eBooks  

• Online Books 
http://onlinebooks.library.upenn.edu/ 
• Gutenberg Project 
http://www.gutenberg.net/index.php 
• Net Library – 24,000 eBooks & 2,000 eAudiobooks. 

Sign up thru your public library, then sign on to NC 
Live, and finally to Net Library. 

http://netlibrary.com/Centers/AudiobookCenter/Browse
.aspx?Category=Lectures 

 
 
Free Online Audiobooks 

• http://librivox.org/newcatalog/search.php?title=&aut
hor=&status=complete&action=Search 

• http://www.audiobooksforfree.com/ 
 
Books on CD & cassette 

North Carolina Library for the Blind (see above) 
http://statelibrary.dcr.state.nc.us/lbph/lbph.htm 
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Downloadable Talking Books for the Blind 
https://www.nlstalkingbooks.org/dtb/ 
 
Audible.com. Over 40,000 current sellers. Annual 
subscription service. 
http://www.audible.com/adbl/site/homepage/AnonHom
e.jsp?BV_UseBVCookie=Yes 
 
Simply Audiobooks. Rental or Download service. 
http://www.simplyaudiobooks.com/ 
 
 
AudioBooks.com. Rent or buy. New or used. 
http://www.audiobooks.com/ 
 
AudioBooks.net. 22,000 paid titles, 500 free titles. 
http://www.audiobooks.net/ 
 
The Talking Books Librarian 
Get the latest developments. 
http://talkingbookslibrarian.blogspot.com/ 
 
Your Local Public Library has books on cassette & 
CD. 
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  Catalogs for Low Vision Products 
 
The Low Vision Store 
• http://www.thelowvisioncenter.com/lowvipr.

html 
• http://www.thelowvisioncenter.com/index.ht

ml?gclid=COaYl5r_iJQCFQrVsgodtQ7vWg 
• http://stores.ebay.com/The-Low-Vision-Store 
 
Independent Living Aids Inc 
http://www.independentliving.com/ 
 
LS&S Products 
http://www.lssproducts.com/ 
 
Beyond Sight 
http://www.beyondsight.com/ 
 
Maxi Aids 
http://www.maxiaids.com/ 
 
Enable Mart 
http://www.enablemart.com/Catalog/Vision 
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Cell Phones  
 
Code Factory - Cell Phone Enhancements 
http://codefactory.es/en/ 
 
Cell Phone Technologist 
Ray Gonzales 
919-523-0205 
http://www.etoengineering.com 
 
Accessible Cell Phones 
http://www.mnlowvision.com/phone.html 
 
The Owasys 22C Screenless Cell Phone 
http://www.screenlessphone.com/ 
 
The Jitterbug phone – large screen, large buttons 
http://www.jitterbug.com/Phones.aspx 
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Computer Settings for Low Vision  
 
Have a comfortable chair and good posture to 
reduce physical fatigue.   
Good lighting in general is an aid for low vision. 
Minimize glare. Adjust lighting and screen angle. 
Take a break every 20 minutes to limit eye strain. 
http://www.uveitis.org/low.html# 
http://www.eterlab.com/eyedefender/ 
http://www.mdsupport.org/library/lighting.html 
 
The Ott-Lite "total- spectrum" bulb that produces 
high color rendering, while retaining excellent 
contrast and visual acuity.For persons with low 
vision, the implications for a light that provides 
enhanced contrast, sharpened clarity, and lower 
glare while it increases illumination and offers true 
color rendering are obvious. In addition, because 
the bulb is cool to the touch, it provides a more 
comfortable work space. 
http://www.ott-lite.com/Cms/vsp.aspx 
 
The following settings will allow you to 
simulate ZoomText using Microsoft Word. 
 
Screen Resolution & Object Size for a PC 

1. Right click on a clear area of the Desktop 
2. Click on Properties on the drop down menu 
3. Alternate method, click on Start> Control 

Panel > Display. 
4. Click on Settings tab 
5. Slide Screen Resolution to left (800 x 600) 
6. Click on Appearance tab 

http://www.uveitis.org/low.html
http://www.eterlab.com/eyedefender/
http://www.mdsupport.org/library/lighting.html
http://www.ott-lite.com/Cms/vsp.aspx


7. Change Font Size to Large 
8. Click on Apply 
9. Click on Color Scheme tab 
10. Choose High Contrast White or Black, to 

suit. 
11. Click on Apply 
12. Click on OK 
13. In upper right corner of window, click on 

Full Screen center box just to the left of the X 
box. 

 
Monitor Contrast & Brightness Settings 

1. Use the Accessiblity Wizard to set contrast & 
icon size. 

2. Go to Start > All Programs > Accessories > 
Accessibility > Accessibility Wizard. 

3. Follow instructions to set preferences. 
 
 
Mouse Settings 

1. Go to Start > Control Panel  
2. Double click on Mouse icon 
3. Click on Pointers tab 
4. Check the Pointer Shadow box 
5. Click on Pointer Options tab 
6. Check the Display pointer trails box & set 

length to medium 
7. Check the box marked Show Location of 

Mouse. 
8. Click on Apply 
9. Click on OK 

 
When needed,  press CTRL key repeatedly to find 
the mouse. 
 
Mouse Dexterity Exercises 

• http://www.seniornet.org/howto/mouseexerc
ises/mousepractice.html 

http://www.seniornet.org/howto/mouseexercises/mousepractice.html
http://www.seniornet.org/howto/mouseexercises/mousepractice.html


• http://www.lakeco.lib.in.us/mouselinks.htm 
 
Computer Tips from SeniorNet 
http://www.seniornet.org/jsnet/index.php?option
=com_content&task=view&id=152&Itemid=1 
 
Increase Website Visibility 

1. To increase the contrast & invert the color of 
the font in a website, click on the paragraph, 
hold down the CTRL key & type A.  

2. To increase the font size, hold down the 
CTRL key & roll the MOUSE WHEEL up. This 
works for most, but not all, websites. 

  
Thumb Drives 
Copy a book or any long document to a thumb 
drive, along with a screen reader, such as 
Browsealoud and SmartRead. Plug this into any 
computer, which will now be activatable & able to 
read. ZoomText is now available on a thumb 
drive. 
 
Document Page Width for 800 x 600 
resolution 

1. In Word, go to File > Page Setup 
2. Click on Margins tab 
3. Set Left margin to 0.5 
4. Set Right margin to 3.5 
5. Click on OK 
6. Select the entire document, CTRL A. 
7. Format Paragraph Left-aligned.  

This simulates Word Wrap. 
 
Magnification in Microsoft Word 

1. Open a Word document, if necessary. 
2. Click in body of the document, if necessary. 
3. Hold down the CTRL key 

http://www.lakeco.lib.in.us/mouselinks.htm
http://www.seniornet.org/jsnet/index.php?option=com_content&task=view&id=152&Itemid=1
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4. Roll the mouse wheel up & down to change 
the font magnification. 

  
Read Out Loud in Microsoft Word 

1. Open a Word document. 
2. Click on Tools > Speech 
3. The Speech Toolbar will appear. 
4. Click mouse pointer where you want Speech 

to begin. 
5. Click Speak in Language Toolbar. 

 
Easy Access Applications 
These are simplified versions of Flickr & YouTube 
for low vision. 
 
Easy Flickr 
http://icant.co.uk/easy-flickr/ 
 
Easy YouTube 
http://icant.co.uk/easy-youtube/ 
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 Financial Aid for Assistive Technology 

 
There are a lot of sites, but very little funding 
available. 
Not covered by Medicare. 
 
ICDRI Advice 
http://www.icdri.org/Finance.htm 
 
US Dept of Health Advice. See page 3. 
http://www.aoa.gov/press/fact/pdf/fs_assitive_tec
h.pdf 
 
Eldercare Locator 
http://www.eldercare.gov/Eldercare/Public/resourc
es/fact_sheets/assistive_tech.asp 
 
NC State Financial Assistance Advice 
http://www.ncatp.org/Funding/Funding%20to%20I
ndividuals.html 
 
New Freedoms Initiative Bill before Congress May 
2008 
http://usgovinfo.about.com/library/weekly/aa0202
01b.htm 
 
Assoc of Blind Citizens AT Fund 
http://www.blindcitizens.org/assistive_tech.htm 
 
Postage Free Mail for the Visually Handicapped 
http://www.usps.com/cpim/ftp/pubs/pub347.pdf 
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http://www.usps.com/cpim/ftp/pubs/pub347.pdf


 
The New Fund – low interest loans for disabled 
Virginians 
http://www.atlfa.org/ 
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  Living with Low Vision 
 
In an ad by an automotive company, there is a 
picture of a woman. She is strong, athletic. She is 
wearing a tee shirt and running shorts. She has 
only one leg; the other is a runner’s high-tech 
prosthetic. 
 
The caption reads “Don’t ever give up.  Not once.  
Not ever.  
My dream is to do extraordinary things every day.   
Life’s calling. Where to next?” 
 
This is the attitude we must bring to low vision. 
 
Low Vision Care is not a surgical procedure or 
medicinal treatment, but rather a rehabilitative 
program to teach you new strategies to maximize 
your remaining vision. 
 
There are a myriad of resources to help you live 
independently and productively. But there is a 
great deal of redundancy between manufacturers. 
Try several alternatives before you commit to a 
solution. Some of you may need our remedial 
computer lessons. Some of you may want to avoid 
computers altogether. Each person is different. 
 
We will show these alternative assistives, some 
free, some inexpensive, some quite expensive. 
Magnifiers can range from a simple magnifying 
glass to an electronic closed circuit TV magnifier, 
such as a Topaz CCTV. Sometimes these freebies 



will do the job for you. Sometimes you will choose 
the professional solutions for their quality & ease 
of use. You may find that screen magnification 
allows you to read a computer screen. Or you 
might find it better to have a computer or an iPod 
read out loud to you. It is up to you. It is your 
choice. 
 
This course consists of three parts: the teachers, 
these notes and you. Of these, YOU are the most 
important part. Your willingness to work hard and 
to learn are essential for your success. 
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 Local Services for those with Low Vision  
 
UNC Eye Center 
UNC Department of Ophthalmology 
Communications Center  
2nd Floor ACC Bldg CB 7720 
Chapel Hill, NC 27599 
919-966-5509 
 
Duke Eye Center                  
Low Vision Unit 
2351 Irwin Rd 
Durham, NC 27710 
(919) 681-3937 
 
Low Vision Support Group 
Contacts: Herb Halbrecht 919-969-1573 
  John Logan  919-957-4247 
  Lauren Tappan 919-929-5256 
 
NC Division of Services for the Blind 
Located at The Governor Morehead School for the Blind 
309 Ashe Ave 
Raleigh, NC 
919-733-9822 
(919) 715-1154 
http://www.ncdhhs.gov/dsb/index.htm 
 
NC Rehab Center for the Blind 
Located at The Governor Morehead School for the Blind 
Pattie Barker 
305 Ashe Ave 
Raliegh, NC, 27606 
Phone: (919) 733-5897 
http://www.dhhs.state.nc.us/dsb/guide.htm 
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North Carolina Assistive Technology Program - 
NCATP 
1110 Navaho Dr.  
Suite 101,  
Raleigh, NC 27609  
919-850-2787 
http://www.ncatp.org/ 
 
NCATP is the largest source in NC for AT demos & trial 
loans. 
NCATP is both free & fee based. NC Services for the Blind 
is all free. 
 
Partnerships in Assistive Technology 
Exchange center for assistive devices, when available. 
1110 Navaho Dr.  
Suite 100,  
Raleigh, NC 27609  
919-872-2298 
http://www.pat.org/ 
 
PAT Expo Exchange Program Dec. 3, 4, 5, 2008 
 
NC Library for the Blind 
1811 Capital Blvd.,  
Raleigh, NC 27635 
(919) 733-4376 
http://statelibrary.dcr.state.nc.us/lbph/lbph.htm 
http://www.loc.gov/NLS/ 
http://www.klas.com/talkingbooks/nc 
 
Magazine for NLS subscribers 
http://www.choicemagazinelistening.org/ 
 
See also AudioBooks & eBooks below. 
 
Foundation for Fighting Blindness 
Eastern Region Office 
4600 Marriott Drive, Suite 340 
Raleigh, NC 27612 
(919) 781-8014 
http://www.blindness.org/ 

http://www.ncatp.org/
http://www.pat.org/
http://statelibrary.dcr.state.nc.us/lbph/lbph.htm
http://www.loc.gov/NLS/
http://www.klas.com/talkingbooks/nc
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Raleigh Durham Chapter, FFB 
Jane Gardner, Chapter President 
5435 N. Highland Drive 
Durham, NC 27712-1921 
919-383-7719 
ncraleigh@fightblindness.org 

Alliance of Disability Advocates 
401 Oberlin Rd., Suite 103 
Raleigh, NC 27605 
919.833.1117 
http://www.alliancecil.org 

 
 The Macular Degeneration Partnership 
 http://www.amd.org/ 
 
  
 The Triangle Radio Reading Service 
 http://www.trianglereadingservice.org/ 
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 Low Vision Blogs & User Groups 

 
Welcome to sci.med.vision 
http://groups.google.com/group/sci.med.vision/br
owse_thread/thread/7348639e81d8ac15?hl=en# 
 
Access Watch 
http://www.accesswatch.info/ 
 
Gordon’s D-Zone 
http://gd-zone.blogspot.com/2008/06/here-i-go-
part-1.html 
 
Marco’s Accessibility Blog 
http://www.marcozehe.de/tag/accessibility/ 
 
BlindConfidential 
http://blindconfidential.blogspot.com/ 
 
Universally Designed 
http://universallydesigned.net/general/reading-
making-it-a-more-pleasant-past-time/ 
 
Low Vision Aids Blog – the latest AT devices 
http://lowvision.wordpress.com/ 
 
Serotek Blog 
http://blog.serotek.com/ 
 
Fred’s Head Companion 
http://www.fredshead.info/ 
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Low Vision Magazines & Newsletters  
 

Dialogue Magazine 
http://www.blindskills.com/dialogue.html 
 
Vision Access Magazine 
http://www.cclvi.org/vaccess/main.htm 
 
EyeWorld Magazine 
http://www.eyeworld.org/ 
 
Low Vision Newsletters 

• http://www.eyeassociates.com/lownews.htm 
• http://www.blind.msstate.edu/Worksight200

6.html 
• http://www.lowvisionclub.com/newsletters.ht

ml 
• http://www.lowvision.com/tips/newsletter-

archive/ 
• http://www.lighthouse.org 
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 Low Vision Web Browsers 
 
Opera Browser adapts for low vision 
Built-in magnifier, adaptable menues, etc. 
http://us.geocities.com/tim_hobbs.geo/opb.htm 
 
Mozilla Firefox Browser does too. 
http://www.mozilla.org/ 
 
Web Eyes – Add-on for Internet Explorer 
http://www.ionwebeyes.com/ 
 
Tips for Browser setup 
http://www.alistapart.com/articles/lowvision/ 
http://63.240.118.132/Section.asp?DocumentID=
1452&SectionID=4 
 
Connect Outloud by Freedom Scientific 
http://www.freedomscientific.com/fs_products/sof
tware_connect.asp 
 
Fire Vox – a screen reader add-on for the FireFox 
browser 
http://www.firevox.clcworld.net/features.html 
 
Web Visum –helpful add-ons for Firefox browser 
http://www.webvisum.com/ 
 
WebLV adds the Internet & email to CCTV 
http://www.jbliss.com/weblv.htm 
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Webbie – Free Low Vision Browser 
http://www.webbie.org.uk/ 
 
IBM Home Page Reader – Talking web browser 
http://www-
03.ibm.com/able/news/hpr_enduser.html 
 
Browsealoud – free software for PC & Mac that 
reads text selected by mouse on compatible 
websites. Mostly in UK. 
http://www.browsealoud.com/page.asp?pg_id=80
004 
 
Accessible Google 
In order to help the visually impaired find the most relevant, useful 
information on the web, and as quickly as possible, Google 
developed Accessible Search. Google Accessible Search identifies 
and prioritizes search results that are more easily used by blind and 
visually impaired users – that means pages that are clean and 
simple (think of the Google homepage!) and that can load without 
images. 
http://labs.google.com/accessible/ 
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Text to Speech Screen Readers for 
Macintoshes 

 
Mac Text to Speech Synthesis 
http://www.apple.com/education/accessibility/tech
nology/text_to_speech.html 
 
TextSpeech Pro for Macs by Digital  Future 
http://www.digitalfuturesoft.com/texttospeechprod
uctsformacosx.php 
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Simple computer keystrokes to control your 
Macintosh: 

 
Universal Access and VoiceOver 

Keyboard 
shortcut 

Description 

Option-
Command-8 

Turn on Zoom 

Option-
Command-+ 
(plus) 

Zoom in 

Option-
Command-- 
(minus) 

Zoom out 

Control-
Option-
Command-8 

Switch to White on Black 

Control-F1 

Turn on Full Keyboard Access 
When Full Keyboard Access is 
turned on, you can use the key 
combinations listed in the table 
below from the Finder. 

Control-F2 
Full Keyboard Access 
     Highlight Menu 

Control-F3 
Full Keyboard Access 
     Highlight Dock 

Control-F4 
Full Keyboard Access 
     Highlight Window (active)  

http://www.apple.com/macosx/features/voiceover/


Control-F5 
Full Keyboard Access 
     Highlight Toolbar 

Control-F6 
Full Keyboard Access 
     Highlight Utility window  

Command-F5  
Turn VoiceOver on or off (Mac OS 
X 10.4 or later) 

Control-
Option-F8  

Open VoiceOver Utility (Mac OS X 
10.4 or later) 

Control-
Option-F7  

Display VoiceOver menu (Mac OS X 
10.4 or later) 

Control-
Option-;  
 

Enable/disable VoiceOver 
Control-Option lock (Mac OS X 10.4 
or later) 

  The Universal Access preference pane allows you 
to turn on Mouse Keys. When Mouse Keys is on, 
you can use the numeric keypad to move the 
mouse.  
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Magnifier Software  
for the Computer Screen 
 
Commercial Computer Magnifiers 
 
Magic by Freedom Scientific, with or without 
speech 
http://www.freedomscientific.com/PDF/lowvision/f
lyers/MAGicFlyer.pdf 
 
ZoomText by Ai Squared, with or without speech 
http://www.aisquared.com/index.cfm 
 
Lunar & Lunar Plus by Dolphin 
http://www.yourdolphin.com/productdetail.asp?id
=3 

 
Free & Low Cost Computer Magnifiers 
Asstd Screen Magnifiers: free, shareware & 
professional. 
Magnification should also do Text Smoothing. 
Many have jagged edges on the font. Some are 
not stable. 

• http://www.magnifiers.org/links/Download_S
oftware/Screen_Magnifiers/ 

• http://www.bluechillies.com/query.php?text=
IE%Magnifier&page=1 

 
Magic Lens Max 

• Customizable lens shape with 3 smooth 
styles (Ellipse, Rounded Rectangle and 
Rectangle)  

• Variable magnification from 1/2x to 32x  
 http://www.visionsuit.com/index.html 
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Dragnifier magnifies mouse area 
http://www.halley.cc/stuff/dragnifier.html 
 
Screen Loupe 
http://www.gregorybraun.com/Loupe.html 
 
ZoomWare, by AISquared, improves screen 
magnification, contrast & color 
http://www.getzoomware.com/videos 
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Magnifiers, Electronic, Hand Held 

 
DinoView portable 
http://www.independentliving.com/prodinfo.asp?n
umber=454658 
 
Optelec Compact+ portable 
http://www.optelec.com/us_en/index.php/product
s/electronic-low-vision/compact-plus/ 
 
Amigo 
http://www.ulva.com/Online-Store/Video-
Magnifiers/amigo.htm 
http://www.enhancedvision.com/products/low_visi
on_assistive_devices.php 
 
Opal by Freedom Scientific 
http://www.accessibility.net/store/Handheld_Mag
nifiers.html 
 
Nemo 
http://www.ulva.com/Online-Store/Video-
Magnifiers/nemo.htm 
 
Smartview Series - 4 new electronic magnifiers 
from Humanware 
http://www.humanware.com/en-
usa/products/low_vision/smartview 
 
The QuickLook video magnifier 
http://www.jbliss.com/quicklook.htm 
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Return to Index 
 
Magnifiers for the Mac 
 
Text magnification is built into the Mac operating 
system. 

 
Coloristic - Simple magnifier utility, that magnifies 
the area around the mouse cursor. Also for 
Windows XP. $12 

 http://www.bubblepop.com/coloristic/index.html 
 

Lupe for Macintosh - from Artis Software, Lupe is a 
FREE screen magnifier utility, that magnifies the 
area around the mouse cursor from 2 to 8 times. ( 

 http://www.artissoftware.com/lupe.html 
 

Macintosh Software Toolkit – freeware & shareware 
utilities that help sight impaired people accessing 
the Macintosh 
http://trace.wisc.edu/world/computer_access/mac/
macshare.html 
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Magnifiers for the Web Browser 

 
 Magnifiers for Internet Explorer 
 

Go to manufacturers web site for Zoom Text & for 
Dolphin’s Hal Screen Reader or Supernova Reader 
Magnifier, as listed here. 

 
 Browser Buddy 
 http://www.bluechillies.com/details/8918.html 
 
 ProSurf 
 http://www.bluechillies.com/details/10133.html 
 
 Hyperjoint Zoom Buttons 
 http://www.bluechillies.com/download/8128.html 
 
 Big.Com free magnifier for Internet Explorer 

http://download.nytimes.com/Big-com-Web-
Magnifier/9100-12777_4-10515888.html?tag=lst-
0-3 

 
Firefox Browser Add-ons 
 
No Squint for FireFox Browser 
https://addons.mozilla.org/en-
US/firefox/addon/2592 
A FireFox browser add-on. It allows you to adjust the default text zoom 
level for any site - and then remembers it on a per-site basis. 

 

http://www.bluechillies.com/details/8918.html
http://www.bluechillies.com/details/10133.html
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https://addons.mozilla.org/en-US/firefox/addon/2592
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Low Browse – free Firefox add-on developed by 
Lighthouse International 
http://lighthouse.org/aboutus/press/press-
releases/lowbrowse 
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Magnifiers, Electronic, Desktop (CCTV) 

 
Topaz by Freedom Scientific 
http://www.accessibility.net/store/CCTV.html 
 
Smartview Extend by Humanware 
http://www.accessibility.net/store/CCTV.html 
http://www.humanware.com/en-
usa/products/low_vision 
 
Jordy Head mounted CCTV 
http://www.nanopac.com/Jordy.htm 
 
Optelec ClearNote+ desktop 
http://www.optelec.com/us_en/index.php/product
s/electronic-low-vision/clearnote/ 
 
Onyx by Freedom Scientific 
http://www.freedomscientific.com/products/lv/ony
x-main-product-page.asp 
http://www.granteyeglasses.com/onyx.html 
 
Merlin CCTV 
http://www.enhancedvision.com/downloads/Merlin
PlusSpecs.pdf 
 
Magnicam works with your TV 
http://www.magnicam.com/ 
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Optical Magnifiers   

 
 
 
How to Choose a 
Magnifier to do the Right 
Job 

• http://www.eschenbach.com/chart.html 
• http://www.eschenbach.com/newsletters/20

0802.pdf 
 
Magnifiers, Optical 
 
Illuminated Magnifiers, Hand held 
http://www.independentliving.com/products.asp?d
ept=79&deptname=Hand-Held-Magnifiers 
 
Illuminated Magnifier, 5 Diopter Rectangular Lens, 
w/Weighted Base 
http://www.all-spec.com/1/viewitem/240-
101/ALLSPEC/prodinfo/w3path=cat 
 
Selsi Magnifiers 
http://www.selsioptics.com/readers.html 
 
Telescopic & Microscopic Eyeglasses 

• http://lowvisiondoctor.com/_wsn/page4.html 

http://www.eschenbach.com/newsletters/200802.pdf
http://www.eschenbach.com/newsletters/200802.pdf
http://www.independentliving.com/products.asp?dept=79&deptname=Hand-Held-Magnifiers
http://www.independentliving.com/products.asp?dept=79&deptname=Hand-Held-Magnifiers
http://www.all-spec.com/1/viewitem/240-101/ALLSPEC/prodinfo/w3path=cat
http://www.all-spec.com/1/viewitem/240-101/ALLSPEC/prodinfo/w3path=cat
http://lowvisiondoctor.com/_wsn/page4.html


• http://www.lowvision-
copihue.com/catalog25x-low-vision-
telescopes.htm 

• http://www.collette-
optical.com/atelescopic.php 

• http://www.activeforever.com/showproduct.a
spx?ProductID=2103&SEName=eschenbach-
maxdetail-glasses 

• http://www.selsioptics.com/Sports-
Glasses.html 
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Portable eBook Storage Devices & Readers  
 

VictorReader Stream by Humanware 
Plays pre-recorded Natl Library for the Blind books 
downloaded via a std. desktop computer. 
Includes Text to Speech Reader for elctronic 
documents. 
http://www.humanware.com/en-
usa/products/dtb_players/compact_models/_detail
s/id_81/victorreader_stream.html 
 
iPod Touch by Apple 
Plays pre-recorded books or photos loaded from 
your desktop. 
Connects to Internet via WiFi including YouTube 
videos, Google Search, News Reader & over 600 
applications. 
Downloads books, songs or podcasts directly from 
iTunes store. 
Sends and receives email. 
http://www.apple.com/ipodtouch/ 
http://www.apple.com/webapps/index.html 
 
The Kindle by Amazon  
Downloads books directly from Amazon via built-in 
internet modem. 
Does not magnify or read out loud … yet. 
http://www.amazon.com/Kindle-Amazons-
Wireless-Reading-Device/dp/B000FI73MA 
http://talkingbookslibrarian.blogspot.com/2007/11
/amazon-announces-kindle-wireless.html 
 

http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.apple.com/ipodtouch/
http://www.apple.com/webapps/index.html
http://www.amazon.com/Kindle-Amazons-Wireless-Reading-Device/dp/B000FI73MA
http://www.amazon.com/Kindle-Amazons-Wireless-Reading-Device/dp/B000FI73MA
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Cybook Gen3 is the European Kindle 
http://www.bookeen.com/ebook/ebook-reading-
device.aspx 
 
iRex iLiad is a larger Kindle. Loads from your 
desktop. 
http://www.irextechnologies.com/products/iliad 
http://en.wikipedia.org/wiki/ILiad_(E-
book_Reader) 
http://www.youtube.com/watch?v=UdlPHxPNw-Y 
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 Proper  Nutrition, Proper Eyecare  
 

Vision Nutrition Article 
http://findarticles.com/p/articles/mi_m1272/is_26
89_131/ai_92691057 
 
Research to Prevent Blindness 
http://www.rpbusa.org/rpb/ 
 
The Vision Learning Center 
http://www.preventblindness.org/vlc/taking_care.
htm 
 
Macular Degeneration Vitamins 
http://www.macular-degeneration-vitamins.com/ 
 
Low-Vision Rehab May Improve Macular Disease 
http://www.emaxhealth.com/96/22247.html 
 
Vision Nutrition 
http://www.vision-nutrition.com/paulharvey.html 
 
The Eye Advisory on eye disease prevention & 
treatment 
http://www.eyeadvisory.com/intro.html 
 
Bilberry & Eye Disease 
http://www.peoplespharmacy.com/archives/herb_
library/bilberry.php 
 
 

http://findarticles.com/p/articles/mi_m1272/is_2689_131/ai_92691057
http://findarticles.com/p/articles/mi_m1272/is_2689_131/ai_92691057
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http://www.emaxhealth.com/96/22247.html
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Cataracts & N-Acetyl-Carnosine 
Peoples Pharmacy quote: “A listener tantalized others with his testimonial on using a 
dietary supplement, l-carnosine, to reverse his cataracts. We discuss this approach 
with the ophthalmologist who suggested it.” Approved in Europe,under test in the 
US, but primary cure for cataracts in US & Europe is still surgery. 

• http://www.peoplespharmacy.com/archives/r
adio_shows/684_health_news_update.php 

• http://www.eyeadvisory.com/cataracts.html 
• http://www.raysahelian.com/carnosine.html 
• http://www.smart-drugs.net/carnosine-

eyedrops-article.htm 
• http://www.weeklyuniverse.com/2004/catara

ct.htm 
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 Scan to Speech Conversion: 

 Converts a physical book to speech. 
 
Daisy EasyReader 
www.yourdolphin.com 
 
OpenBook 
http://www.freedomscientific.com/products/fs/ope
nbook-product-page.asp 
 
SARA 
http://www.freedomscientific.com/products/lv/sara
-product-page.asp 
 
Kurzweil 3000 Professional 
http://www.kurzweiledu.com/kurz3000.aspx#q1 
 
KNFB Reader on a cell phone 

• http://www.knfbreader.com/ 
• http://gizmodo.com/349558/kurzweil-

develops-first-seeing+eye-cellphone 
 

Zoom-Ex is a fast, packaged, light weight scan to 
speech unit. It folds up and fits in your laptop bag. 
Runs on any Windows-based computer or laptop. 
http://www.zoom-
ex.com/html/zoomex_products_zoom_ex.htm 
Review & prices for Zoom-Ex in Vision Access 
Magazine, Vol. 14, No. 4, Page 43. 
http://www.cclvi.org/vaccess/main.htm 

 
An inexpensive alternative approach is to scan the 
document on any scanner. Buy one that can scan 
bound books. This first step just makes a picture of 

http://www.yourdolphin.com/
http://www.freedomscientific.com/products/fs/openbook-product-page.asp
http://www.freedomscientific.com/products/fs/openbook-product-page.asp
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http://www.zoom-ex.com/html/zoomex_products_zoom_ex.htm
http://www.zoom-ex.com/html/zoomex_products_zoom_ex.htm
http://www.cclvi.org/vaccess/main.htm


the document. Then run it thru OCR software such 
as IRIS, Kurzweil 1000 or FineReader, converting it 
to real text. Then read that file out loud with a 
screen reader. 
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 Speech Recognition for Macs 
You speak into a microphone & the computer obeys 
the command or types a document. 
 
Comparison 
http://speechwiki.org/out-loud/mac.html 
 
Instructional Video 
http://lifehacker.com/software/speech-
recognition/hack-attack-make-your-macs-speech-
recognition-work-for-you-215764.php 
 
MacSpeech Dictate  
http://www.macspeech.com/ 
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 Speech to Text Conversion,  
 Speech Recognition 

 The computer types what you speak. 
 Enter computer commands verbally. 

 
Dragon Naturally Speaking Speech Recognition 
Software 9.0+ 

• Speak rather than type.  
• Spell correctly every time. 
• Move around your document, format 

paragraphs, and even move your mouse by 
voice. 

http://www.nuance.com/naturallyspeaking/ 
 
MacSpeech Speech Recognition for Macintoshes 
http://www.macspeech.com/pages.php?cID=4&pID
=24 
 
 
Microsoft Speech Recognition 
Part of the MS Word Speech Toolbar 
Must be taught to recognize your speech. 
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 Text to Speech (TTS) Screen Readers,  
 Software for Computers 

 Have your computer read to you. 
 
 BBC Screen Reader Testing Guidelines 

http://209.85.215.104/search?q=cache:WxmnUYW
LDUUJ:www.bbc.co.uk/guidelines/newmedia/access
ibility/screenreader.shtml+how+%22screen+reade
r%22+UK&hl=en&ct=clnk&cd=2&gl=us 
 
Comparison of Web-based Text to Speech 
programs. 
Info is helpful, but live links are not functional. 
http://www.laits.utexas.edu/hebrew/personal/tts/t
able.html 
 
 Commercial Screen Readers for the Blind 
 
JAWS screen reader by Freedom Scientific 
http://www.freedomscientific.com/fs_products/soft
ware_jaws.asp 
http://en.wikipedia.org/wiki/JAWS_(screen_reader) 
 

 HAL by Dolphin 
http://www.yourdolphin.com/productdetail.asp?id=
5 

 
Commercial Screen Readers for Low Vision 

 
Magic by Freedom Scientific, with JAWS speech 
http://www.freedomscientific.com/PDF/lowvision/fl
yers/MAGicFlyer.pdf 
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ZoomText Reader by Ai Squared,  
http://www.aisquared.com/index.cfm 
 
Lunar Plus by Dolphin 
http://www.yourdolphin.com/productdetail.asp?id=
3 
 
Window-Eyes screen reader by GWMicro 
http://www.gwmicro.com/Window-Eyes/ 
 
TextAloud screen readers by Nextup 
Uses Acapela voices 
http://www.nextup.com/products.html 
 
Infovox Desktop  for Windows – screen reader by 
Acapela 
http://www.acapela-group.com/infovox-desktop-
for-windows-3-speech-solutions.html 
 
Free & Low Cost Screen Readers for Low 
Vision 
Many of these are experimental. Proceed with 
caution. 
 
Text to Speech Shareware 
http://www.sharewareconnection.com/titles/speech
-to-text.htm 
 
SmartRead - Free Computer Screen Reader 
http://www.smartysoft.com/index.php 
 
Speech Synthesizer 5.0 
http://www.caltrox.com/products/speech.htm 
 
TextSpeech Pro for PCs by Digital  Future 
http://www.textspeechpro.com/download.html 
 
Free Text to Speech software by Dimio’s Tools 
http://dimio.altervista.org/eng/ 
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Help Read - a free text reader 
http://www.pixi.com/~reader1/allbrowser/ 
 
Read Please & Read Please Plus 
http://www.readplease.com/english/readplease.ph
p 
 
Say Pad text to speech also can create Text to 
Audio MP3 files 
http://www.afreego.com/Categories/Multimedia/MP
3/006712.php 
 
Read to Me text to speech reader 
http://download.nytimes.com/Read-to-Me-Text-To-
Speech/9100-7239_4-10702544.html?tag=lst-0-2 
 
Verbose Text to Speech Converter 
http://www.nch.com.au/verbose/index.html 

 
NVDA - NonVisual Desktop Access (NVDA) is a free and open source 
screen reader for the Microsoft Windows operating system. 
http://www.nvda-project.org/ 
 
Talklets by Textic Textic, the company behind Talklets, has 
developed breakthrough technology for turning web content into speech. 
http://www.textic.com/index.html 
http://assistivetek.blogspot.com/ 
 
 
 
Text to Speech conversion is built into Microsoft 
Word. 

1) Choose Speech in the Tools menu 
2) Select Speak in the floating Speech toolbar 
3) If “Speak” is not visible, click on small down 

arrow at end of Speech toolbar & select. 
 
Text to Speech conversion is built into Adobe 
Acrobat Reader 8.0 and later: 
1) Set up in Edit > Preferences > Reading > Read 
Out Loud  Options. 

http://www.pixi.com/%7Ereader1/allbrowser/
http://www.readplease.com/english/readplease.php
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2) Activate in View > Read Out Loud > Activate 
 

 Text to Speech is built into the Mac Leopard OS X 
 Cmd-F5 starts Voice Over 
 

Talking Dictionary on your computer 
http://benolsatuem.com/2008/07/talking-
dictionary-710.html 

 
WebAnywhere … web-based screen reader for the 
web. 

 Online text to speech reader runs on Internet. 
 Still under development. 

• http://www.networkworld.com/community/no
de/29310 

• http://webinsight.cs.washington.edu/papers/w
ebanywhere-html/ 

• http://webanywhere.cs.washington.edu/ 
• http://www.eschoolnews.com/news/top-

news/?i=54514;_hbguid=1acccdf1-82d9-
4583-bdf2-efcf294c5f81&d=top-news 

• http://www.msnbc.msn.com/id/25630182/pag
e/2/ 

 
Odiogo - It transforms news sites and blog posts into high 
fidelity, near human quality audio files ready to download 
and play anywhere, anytime, on any device, MP3 or iPod. 
http://www.odiogo.com/ 

 
Menus That Talk – a service available at some 
restaurants 

 http://www.menusthattalk.com/products.html 
 

Return to Index 
 

http://benolsatuem.com/2008/07/talking-dictionary-710.html
http://benolsatuem.com/2008/07/talking-dictionary-710.html
http://www.networkworld.com/community/node/29310
http://www.networkworld.com/community/node/29310
http://webinsight.cs.washington.edu/papers/webanywhere-html/
http://webinsight.cs.washington.edu/papers/webanywhere-html/
http://webanywhere.cs.washington.edu/
http://www.eschoolnews.com/news/top-news/?i=54514;_hbguid=1acccdf1-82d9-4583-bdf2-efcf294c5f81&d=top-news
http://www.eschoolnews.com/news/top-news/?i=54514;_hbguid=1acccdf1-82d9-4583-bdf2-efcf294c5f81&d=top-news
http://www.eschoolnews.com/news/top-news/?i=54514;_hbguid=1acccdf1-82d9-4583-bdf2-efcf294c5f81&d=top-news
http://www.msnbc.msn.com/id/25630182/page/2/
http://www.msnbc.msn.com/id/25630182/page/2/
http://www.odiogo.com/
http://www.menusthattalk.com/products.html


Speech to Text Conversion 
Return to Index 
 
 The Apple Macintosh & its Special Strengths 
 
The Apple Macintosh has an excellent set of 
assistives built into the operating system. It 
is capable of text magnification and text to 
speech conversion without additional 
software. 
 
Apple’s commitment to accessibility is 
evident throughout the Mac OS X operating 
system, which is not only easy to use by 
design, but also includes a wide variety of 
features and technologies specifically 
designed to provide access to users with 
disabilities. Apple refers to these features 
collectively as Universal Access and has 
integrated them into the operating system so they 
can be used in conjunction with a variety of 
applications from Apple and other developers. 
Apple is also changing the ways people interact 
with technology through innovative products like 
the iPhone, which bring new possibilities for making 
user interfaces accessible to users with disabilities. 

The new features in Universal Access.  

http://www.apple.com/macosx/features/300.html#
universalaccess 

Accessibility Technologies in Mac OS X 

 Zoom  
 Full keyboard navigation  
 Sticky Keys and Slow Keys  

http://www.apple.com/macosx/features/300.html#universalaccess
http://www.apple.com/macosx/features/300.html#universalaccess
http://www.apple.com/accessibility/vision/index.html#zoom
http://www.apple.com/accessibility/physical/index.html#keyboard
http://www.apple.com/accessibility/physical/index.html#slow


 Mouse Keys  
 Closed-Captioning in QuickTime  
 Visual alert  
 Spoken items  
 Talking alerts  
 Speech recognition  
 Display adjustment  

http://www.apple.com/accessibility/voiceover/man
ual.html 

Return to Index 
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 The  Low Vision Gateway  

 
Intro to various aspects of Low Vision 

• http://www.lowvision.org/ 
• http://www.lowvisioninfo.org/ 
• http://www.lowvisionfriends.com/ 

 
 VisionAware.org, a "Self-Help for Vision Loss" web 

site that provides free, practical, hands-on information to 
enhance quality of life and independence for adults with 
vision loss, their families and friends, caregivers, and 
related professionals. 
http://www.visionaware.org/ 
 
Return to Index 
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Transportation & Low Vision  

 
What can you do now that you can no longer 
drive: 

 Shuttle Buses 
 Public Transportation 
 Shuttle Services 
 Taxis 
 Friends & relatives 
 Car Pools 
 Walking 
 GPS Navigation 

 
On-going Plans for transport in the Durham/chapel 
Hill area 

• http://citizenwill.org/2007/03/07/campos-
racetrack-5-miles-
long/http://www.owdna.org/issues.htm 

• http://www.facilities.ufl.edu/cp/pdf/PeopleMo
vers.pdf 

 
Durham Area Transit Authority – DATA 

• http://data.durhamnc.gov/Index_DATA.cfm 
• http://data.durhamnc.gov/access.cfm 

 
Google Ride Finder (under development) 
http://labs.google.com/ridefinder 
 
 
Google Transit – Plan a trip using public transport 
(Works in some cities.) 
http://www.google.com/transit 
 

http://citizenwill.org/2007/03/07/campos-racetrack-5-miles-long/
http://citizenwill.org/2007/03/07/campos-racetrack-5-miles-long/
http://citizenwill.org/2007/03/07/campos-racetrack-5-miles-long/
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http://www.facilities.ufl.edu/cp/pdf/PeopleMovers.pdf
http://data.durhamnc.gov/Index_DATA.cfm
http://data.durhamnc.gov/access.cfm
http://labs.google.com/ridefinder
http://www.google.com/transit


Trekker Breeze … hand-held talking GPS device... 
simply press a button and Breeze tells you your 
street location on the spot as you walk or ride in a 
vehicle. 
http://www.humanware.com/en-
usa/products/gps/trekker_breeze/_details/id_101/
trekker_breeze.html 
 
The Sonic Pathfinder – a travel aid for the blind 
http://www.sonicpathfinder.org/ 
 
Electronic Travel Aids for Low Vision 

• http://www.noogenesis.com/eta/current.html 
• http://www.seeingwithsound.com/extra/Sona

r_ETA.doc 
• http://www.wayfinding.net/eta.htm 
• http://www.abledata.com/abledata.cfm?page

id=19327&ksectionid=19327&top=10414 
 
Return to Index 
 

http://www.humanware.com/en-usa/products/gps/trekker_breeze/_details/id_101/trekker_breeze.html
http://www.humanware.com/en-usa/products/gps/trekker_breeze/_details/id_101/trekker_breeze.html
http://www.humanware.com/en-usa/products/gps/trekker_breeze/_details/id_101/trekker_breeze.html
http://www.sonicpathfinder.org/
http://www.noogenesis.com/eta/current.html
http://www.seeingwithsound.com/extra/Sonar_ETA.doc
http://www.seeingwithsound.com/extra/Sonar_ETA.doc
http://www.wayfinding.net/eta.htm
http://www.abledata.com/abledata.cfm?pageid=19327&ksectionid=19327&top=10414
http://www.abledata.com/abledata.cfm?pageid=19327&ksectionid=19327&top=10414




 
Living with Low Vision 
In an ad by an automotive company, there is a picture of a woman. 
She is strong, athletic. She is wearing a tee shirt and running shorts. 
She has only one leg; the other is a runner’s high-tech prosthetic. 
 
The caption reads “Don’t ever give up.  Not once.  Not ever.  
My dream is to do extraordinary things every day.   
Life’s calling. Where to next?” 
 
This is the attitude we must bring to low vision. 
 
Low Vision Care is not a surgical procedure or medicinal treatment, 
but rather a rehabilitative program to teach you new strategies to 
maximize your remaining vision. 
 
There are a myriad of resources to help you live independently and 
productively. But there is a great deal of redundancy between 
manufacturers. Try several alternatives before you commit to a 
solution. Some of you may need our remedial computer lessons. 
Some of you may want to avoid computers altogether. Each person is 
different. 
 
We will show these alternative assistives, some free, some 
inexpensive, some quite expensive. Magnifiers can range from a 
simple magnifying glass to an electronic closed circuit TV magnifier, 
such as a Topaz CCTV. Sometimes these freebies will do the job for 
you. Sometimes you will choose the professional solutions for their 
quality & ease of use. You may find that screen magnification allows 
you to read a computer screen. Or you might find it better to have a 
computer or an iPod read out loud to you. It is up to you. It is your 
choice. 
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This course consists of three parts: the teachers, these notes and 
you. Of these, YOU are the most important part. Your willingness to 
work hard and to learn are essential for your success. 
 
  Course Outline & Index 
 
Computer Proficiency Survey 

Computer Settings 

Websites with Useful Advice for the Visually Challenged 

Local Services for those with Low Vision 

Transportation & Low Vision 

Catalogs for Low Vision Products 

Low Vision Gateway - Intro to various aspects of Low Vision 

Proper Nutrition, Proper Eyecare 

Optical Magnifiers 

Cell Phones 

AudioBooks & eBooks 

eBook Readers 

Low Vision Magazines & Newsletters 

Low Vision Blogs & User Groups 

Portable eBook Storage Devices 

Magnifiers, Electronic, Hand Held 

Magnifiers, Electronic, Desktop (CCTV) 

Magnifiers, Software for Computer Screen 

Magnifiers for the Web Browser 

Low Vision Web Browsers 

Magnifiers for the Macintosh 

Text to Speech Screen Readers, Software for Computers 
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Scan to Speech Conversion 

Speech to Text Conversion, Speech Recognition 

The Apple Macintosh & its Special Strengths 

Mac Voice-Over Commands 

Text to Speech Screen Readers for Macintoshes 

Speech Recognition for Macs 

Financial Aid for Assistive Technology 

 
 
Computer Settings for Low Vision  

 
Have a comfortable chair and good posture to reduce physical 
fatigue.   
Good lighting in general is an aid for low vision. Minimize glare. 
Adjust lighting and screen angle. 
Take a break every 20 minutes to limit eye strain. 
http://www.uveitis.org/low.html# 
http://www.eterlab.com/eyedefender/ 
http://www.mdsupport.org/library/lighting.html 
 
The Ott-Lite "total- spectrum" bulb that produces high color rendering, 
while retaining excellent contrast and visual acuity.For persons with low 
vision, the implications for a light that provides enhanced contrast, 
sharpened clarity, and lower glare while it increases illumination and offers 
true color rendering are obvious. In addition, because the bulb is cool to 
the touch, it provides a more comfortable work space. 
http://www.ott-lite.com/Cms/vsp.aspx 
 
The following setting will allow you to simulate ZoomText 
using Microsoft Word. 
 
Screen Resolution & Object Size for a PC 

1. Right click on a clear area of the Desktop 
2. Click on Properties on the drop down menu 
3. Alternate method, click on Start> Control Panel > Display. 
4. Click on Settings tab 
5. Slide Screen Resolution to left (800 x 600) 
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6. Click on Appearance tab 
7. Change Font Size to Large 
8. Click on Apply 
9. Click on Color Scheme tab 
10. Choose High Contrast White or Black, to suit. 
11. Click on Apply 
12. Click on OK 
13. In upper right corner of window, click on Full Screen 

center box just to the left of the X box. 
 

Monitor Contrast & Brightness Settings 
Use the Accessiblity Wizard to set contrast & icon size 

1. Go to Start > All Programs > Accessories > Accessibility > 
Accessibility Wizard 

2. Follow instructions to set preferences. 
 

 
Mouse Settings 

1. Go to Start > Control Panel  
2. Double click on Mouse icon 
3. Click on Pointers tab 
4. Check the Pointer Shadow box 
5. Click on Pointer Options tab 
6. Check the Display pointer trails box & set length to medium 
7. Check the box marked Show Location of Mouse. 
8. Click on Apply 
9. Click on OK 

 
 When needed,  press CTRL key repeatedly to find the 
 mouse. 
 
Mouse Dexterity Exercises 

• http://www.seniornet.org/howto/mouseexercises/mousepra
ctice.html 

• http://www.lakeco.lib.in.us/mouselinks.htm 
 
Computer Tips from SeniorNet 
http://www.seniornet.org/jsnet/index.php?option=com_content
&task=view&id=152&Itemid=1 
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Increase Website Visibility 

To increase the contrast & invert the color of the font in a 
website, click on the paragraph, hold down the CTRL key & 
type A.  
To increase the font size, hold down the CTRL key & roll the 
MOUSE WHEEL up. This works for most, but not all, 
websites. 

  
 Thumb Drives 

Copy a book or any long document to a thumb drive, along 
with a screen reader, such as Browsealoud and SmartRead. 
Plug this into any computer, which will now be activatable & 
able to read.  
 

 Document Page Width for 800 x 600 resolution 
In Word, go to File > Page Setup 
Click on Margins tab 
Set Left margin to 0.5 
Set Right margin to 3.5 
Click on OK 
Select the entire document, CTRL A. 
Format Paragraph Left-aligned.  

 
 Magnification in Microsoft Word 

 Open a Word document, if necessary. 
 Click in body of the document, if necessary. 
 Hold down the CTRL key 
 Roll the mouse wheel up & down to change the font 
 magnification. 

  
 Read Out Loud in Microsoft Word 
  Open a Word document. 
  Click on Tools > Speech 
  The Speech Toolbar will appear. 
  Click mouse pointer where you want Speech to begin. 
  Click Speak in Language Toolbar. 

 5



 
  Easy Access Applications 

  These are simplified versions of Flickr & YouTube for  
  low vision. 
 
 Easy Flickr 
  http://icant.co.uk/easy-flickr/ 
 
 Easy YouTube 
  http://icant.co.uk/easy-youtube/ 
 
 

 
Return to Index 

 
 
  Websites with Useful Advice for the Visually Challenged 
 

How Can I Organize My Kitchen To Find Things More Easily? 
http://www.visionaware.org/how_can_i_organize_my_kitchen_t
o_find_things_more_easily 
 
Useful Home Adaptations for The Blind and Visually Impaired 
http://www.lowvision.com/tips/useful-home-adaptations-for-
the-blind-and-visually-impaired/ 
 
Adapting To Reduced Vision From Age-Related Macular 
Degeneration 
http://www.cigna.com/healthinfo/rt1271.html 
 
Online Lessons on Living Better at Home 
http://www.lighthouse.org/livingbetter/ 
 
How to Find a Dropped Object 
http://www.visionaware.org/locating-dropped-objects 
 
Videos about Low Vision 

• http://video.google.com/videosearch?q=%22low+vision%2
2&sitesearch=# 
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• http://uk.youtube.com/watch?v=fw91hsVrf40 
• http://www.webmd.com/video/tips-for-better-vision 
• http://www.videojug.com/film/how-to-cope-with-sight-

loss-2 
• http://www.eyecareamerica.org/eyecare/conditions/low-

vision/video.cfm 
 

Low Vision Simulation 
http://www.lowvisionsimulationkit.com/products.html 
http://www.lowvisiononline.unimelb.edu.au/LowVision/LowVision
_simulation.htm 
 
 
Op Lights 
 
Return to Index 
 

  Local Services for those with Low Vision  
 
UNC Eye Center 
UNC Department of Ophthalmology 
Communications Center 
2nd Floor ACC Bldg CB 7720 
Chapel Hill, NC 27599 
919-966-5509 

 
Duke Eye Center                  
Low Vision Unit 
2351 Irwin Rd 
Durham, NC 27710 
(919) 681-3937 
 
Low Vision Support Group 
Contacts: Herb Halbrecht 919-969-1573 
  John Logan  919-957-4247 
  Lauren Tappan 919-929-5256 
 
NC Division of Services for the Blind 
Located at The Governor Morehead School for the Blind 
309 Ashe Ave 
Raleigh, NC 
919-733-9822 
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(919) 715-1154 
http://www.ncdhhs.gov/dsb/index.htm 
 
NC Rehab Center for the Blind 
Located at The Governor Morehead School for the Blind 
Pattie Barker 
305 Ashe Ave 
Raliegh, NC, 27606 
Phone: (919) 733-5897 
http://www.dhhs.state.nc.us/dsb/guide.htm 
 
North Carolina Assistive Technology Program - NCATP 
1110 Navaho Dr.  
Suite 101,  
Raleigh, NC 27609  
919-850-2787 
http://www.ncatp.org/ 
 
NCATP is the largest source in NC for AT demos & trial loans. 
NCATP is both free & fee based. NC Services for the Blind is free. 
 
Partnerships in Assistive Technology 
Exchange center for assistive devices, when available. 
1110 Navaho Dr.  
Suite 100,  
Raleigh, NC 27609  
919-872-2298 
http://www.pat.org/ 
 
PAT Expo Exchange Program Dec. 3, 4, 5, 2008 
 
NC Library for the Blind 
1811 Capital Blvd.,  
Raleigh, NC 27635 
(919) 733-4376 
http://statelibrary.dcr.state.nc.us/lbph/lbph.htm 
http://www.loc.gov/NLS/ 
http://www.klas.com/talkingbooks/nc 
 
Magazine for NLS subscribers 
http://www.choicemagazinelistening.org/ 
 
See also AudioBooks & eBooks below. 
 
Foundation for Fighting Blindness 
Eastern Region Office 
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4600 Marriott Drive, Suite 340 
Raleigh, NC 27612 
(919) 781-8014 
http://www.blindness.org/ 

Raleigh Durham Chapter, FFB 
Jane Gardner, Chapter President 
5435 N. Highland Drive 
Durham, NC 27712-1921 
919-383-7719 
ncraleigh@fightblindness.org 

 
Alliance of Disability Advocates 
401 Oberlin Rd., Suite 103 
Raleigh, NC 27605 
919.833.1117 
http://www.alliancecil.org 

 
 The Macular Degeneration Partnership 
 http://www.amd.org/ 
 
  
 The Triangle Radio Reading Service 
 http://www.trianglereadingservice.org/ 
 
 

Return to Index 
 
  Transportation & Low Vision  
  
 What can you do now that you can no longer drive: 

 Shuttle Buses 
 Public Transportation 
 Shuttle Services 
 Taxis 
 Friends & relatives 
 Car Pools 
 Walking 
 GPS Navigation 

 
On-going Plans for transport in the Durham/chapel Hill area 
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• http://citizenwill.org/2007/03/07/campos-racetrack-5-
miles-long/ 

• http://www.owdna.org/issues.htm 
• http://www.facilities.ufl.edu/cp/pdf/PeopleMovers.pdf 

 
Durham Area Transit Authority – DATA 
http://data.durhamnc.gov/Index_DATA.cfm 
http://data.durhamnc.gov/access.cfm 
 
Google Ride Finder (under development) 
http://labs.google.com/ridefinder 
 
Google Transit – Plan a trip using public transport 
http://www.google.com/transit 
 
Trekker Breeze … hand-held talking GPS device... simply press a 
button and Breeze tells you your street location on the spot as 
you walk or ride in a vehicle. 
http://www.humanware.com/en-
usa/products/gps/trekker_breeze/_details/id_101/trekker_breez
e.html 
 
The Sonic Pathfinder – a travel aid for the blind 
http://www.sonicpathfinder.org/ 
 
 
 
Electronic Travel Aids for Low Vision 

• http://www.noogenesis.com/eta/current.html 
• http://www.seeingwithsound.com/extra/Sonar_ETA.doc 
• http://www.wayfinding.net/eta.htm 
• http://www.abledata.com/abledata.cfm?pageid=19327&kse

ctionid=19327&top=10414 
 
Return to Index 
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  Catalogs for Low Vision Products 
 
The Low Vision Store 

• http://www.thelowvisioncenter.com/lowvipr.html 
• http://www.thelowvisioncenter.com/index.html?gclid=COaY

l5r_iJQCFQrVsgodtQ7vWg 
• http://stores.ebay.com/The-Low-Vision-Store 

 
Independent Living Aids Inc 
http://www.independentliving.com/ 
 
 
LS&S Products 
http://www.lssproducts.com/ 
 
Beyond Sight 
http://www.beyondsight.com/ 
 
Maxi Aids 
http://www.maxiaids.com/ 
 
Enable Mart 
http://www.enablemart.com/Catalog/Vision 
 
 
Return to Index 
 
 

  The Low Vision Gateway  
 

Intro to various aspects of Low Vision 
• http://www.lowvision.org/ 
• http://www.lowvisioninfo.org/ 
• http://www.lowvisionfriends.com/ 

 
 VisionAware.org, a "Self-Help for Vision Loss" web site that provides 

free, practical, hands-on information to enhance quality of life and 
independence for adults with vision loss, their families and friends, 
caregivers, and related professionals. 
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http://www.visionaware.org/ 
 
Return to Index 
 

  Proper Nutrition, Proper Eyecare  
 
Vision Nutrition Article 
http://findarticles.com/p/articles/mi_m1272/is_2689_131/ai_
92691057 
 
Research to Prevent Blindness 
http://www.rpbusa.org/rpb/ 
 
The Vision Learning Center 
http://www.preventblindness.org/vlc/taking_care.htm 
 
Macular Degeneration Vitamins 
http://www.macular-degeneration-vitamins.com/ 
 
Low-Vision Rehab May Improve Macular Disease 
http://www.emaxhealth.com/96/22247.html 
 
Vision Nutrition 
http://www.vision-nutrition.com/paulharvey.html 
 
The Eye Advisory on eye disease prevention & treatment 
http://www.eyeadvisory.com/intro.html 
 
Bilberry & Eye Disease 
http://www.peoplespharmacy.com/archives/herb_library/bilb
erry.php 
 
Cataracts & N-Acetyl-Carnosine 
Peoples Pharmacy quote: “A listener tantalized others with his testimonial on using a dietary 
supplement, l-carnosine, to reverse his cataracts. We discuss this approach with the ophthalmologist 
who suggested it.” Approved in Europe,under test in the US, but primary cure for cataracts in Europe is 
still surgery. 

• http://www.peoplespharmacy.com/archives/radio_show
s/684_health_news_update.php 

• http://www.eyeadvisory.com/cataracts.html 
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• http://www.raysahelian.com/carnosine.html 
• http://www.smart-drugs.net/carnosine-eyedrops-

article.htm 
• http://www.weeklyuniverse.com/2004/cataract.htm 

 
Return to Index 
 
 

  Optical Magnifiers   
 
 
 
How to Choose a Magnifier to do the Right 
Job 
http://www.eschenbach.com/chart.html 

http://www.eschenbach.com/newsletters/200802.pdf 
 
Magnifiers, Optical 
 

Illuminated Magnifiers, Hand held 
http://www.independentliving.com/products.asp?dept=79&dept
name=Hand-Held-Magnifiers 
 
Illuminated Magnifier, 5 Diopter Rectangular Lens, w/Weighted 
Base 
http://www.all-spec.com/1/viewitem/240-
101/ALLSPEC/prodinfo/w3path=cat 
 
Selsi Magnifiers 
http://www.selsioptics.com/readers.html 
 

Telescopic & Microscopic Eyeglasses 
• http://lowvisiondoctor.com/_wsn/page4.html 
• http://www.lowvision-copihue.com/catalog25x-low-vision-

telescopes.htm 
• http://www.collette-optical.com/atelescopic.php 
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• http://www.activeforever.com/showproduct.aspx?ProductI
D=2103&SEName=eschenbach-maxdetail-glasses 

• http://www.selsioptics.com/Sports-Glasses.html 
 

Return to Index 
 
 

   Cell Phones  
 
Code Factory - Cell Phone Enhancements 
http://codefactory.es/en/ 
 
Cell Phone Technologist 
Ray Gonzales 
919-523-0205 
http://www.etoengineering.com 
 
 
Accessible Cell Phones 
http://www.mnlowvision.com/phone.html 
 
The Owasys 22C Screenless Cell Phone 
http://www.screenlessphone.com/ 
 
The Jitterbug phone – large screen, large buttons 
http://www.jitterbug.com/Phones.aspx 
 
 
Return to Index 
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  AudioBooks & eBooks  

 
Audiobooks are read to you by a recorded actor. eBooks allow 
you to download the book,  magnify the type size and have the 
computer read to you out loud. 
 
Free Online eBooks  

• Online Books 
http://onlinebooks.library.upenn.edu/ 
• Gutenberg Project 
http://www.gutenberg.net/index.php 
• Net Library – 24,000 eBooks & 2,000 eAudiobooks. Sign up thru your 

public library, then sign on to NC Live, and finally to Net Library. 
http://netlibrary.com/Centers/AudiobookCenter/Browse.aspx?Category=
Lectures 

 
 
Free Online Audiobooks 

• http://librivox.org/newcatalog/search.php?title=&author=&status=co
mplete&action=Search 

• http://www.audiobooksforfree.com/ 
 
Books on CD & cassette 

North Carolina Library for the Blind (see above) 
http://statelibrary.dcr.state.nc.us/lbph/lbph.htm 
 
Downloadable Talking Books for the Blind 
https://www.nlstalkingbooks.org/dtb/ 
 
Audible.com. Over 40,000 current sellers. Annual subscription service. 
http://www.audible.com/adbl/site/homepage/AnonHome.jsp?BV_UseBV
Cookie=Yes 
 
Simply Audiobooks. Rental or Download service. 
http://www.simplyaudiobooks.com/ 
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AudioBooks.com. Rent or buy. New or used. 
http://www.audiobooks.com/ 
 
AudioBooks.net. 22,000 paid titles, 500 free titles. 
http://www.audiobooks.net/ 
 
The Talking Books Librarian 
Get the latest developments. 
http://talkingbookslibrarian.blogspot.com/ 
 
Your Local Public Library has books on cassette & CD. 
 

Return to Index 
 
 
 
 
 

  Low Vision Magazines & Newsletters  
 

Dialogue Magazine 
http://www.blindskills.com/dialogue.html 
 
Vision Access Magazine 
http://www.cclvi.org/vaccess/main.htm 
 
EyeWorld Magazine 
http://www.eyeworld.org/ 
 
Low Vision Newsletters 

• http://www.eyeassociates.com/lownews.htm 
• http://www.blind.msstate.edu/Worksight2006.html 
• http://www.lowvisionclub.com/newsletters.html 
• http://www.lowvision.com/tips/newsletter-archive/ 
• http://www.lighthouse.org 

 
 
Return to Index 
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   Low Vision Blogs & User Groups 
 

Welcome to sci.med.vision 
http://groups.google.com/group/sci.med.vision/browse_thread/t
hread/7348639e81d8ac15?hl=en# 
 
Access Watch 
http://www.accesswatch.info/ 
 
Gordon’s D-Zone 
http://gd-zone.blogspot.com/2008/06/here-i-go-part-1.html 
 
Marco’s Accessibility Blog 
http://www.marcozehe.de/tag/accessibility/ 
 
BlindConfidential 
http://blindconfidential.blogspot.com/ 
 
 
Universally Designed 
http://universallydesigned.net/general/reading-making-it-a-
more-pleasant-past-time/ 
 
Low Vision Aids Blog – the latest AT devices 
http://lowvision.wordpress.com/ 
 
Serotek Blog 
http://blog.serotek.com/ 
 
Fred’s Head Companion 
http://www.fredshead.info/ 
 
 
Return to Index 

 
 
 
 
 

 17

http://groups.google.com/group/sci.med.vision/browse_thread/thread/7348639e81d8ac15?hl=en
http://groups.google.com/group/sci.med.vision/browse_thread/thread/7348639e81d8ac15?hl=en
http://www.accesswatch.info/
http://gd-zone.blogspot.com/2008/06/here-i-go-part-1.html
http://www.marcozehe.de/tag/accessibility/
http://blindconfidential.blogspot.com/
http://universallydesigned.net/general/reading-making-it-a-more-pleasant-past-time/
http://universallydesigned.net/general/reading-making-it-a-more-pleasant-past-time/
http://lowvision.wordpress.com/
http://blog.serotek.com/
http://www.fredshead.info/


  Portable eBook Storage Devices & Readers  
 

VictorReader Stream by Humanware 
Plays pre-recorded Natl Library for the Blind books downloaded 
via a std. desktop computer. 
Includes Text to Speech Reader for elctronic documents. 
http://www.humanware.com/en-
usa/products/dtb_players/compact_models/_details/id_81/victor
reader_stream.html 
 
iPod Touch by Apple 
Plays pre-recorded books or photos loaded from your desktop. 
Connects to Internet via WiFi including YouTube videos, Google 
Search, News Reader & over 600 applications. 
Downloads books, songs or podcasts directly from iTunes store. 
Sends and receives email. 
http://www.apple.com/ipodtouch/ 
http://www.apple.com/webapps/index.html 
 
The Kindle by Amazon  
Downloads books directly from Amazon via built-in internet 
modem. 
Does not magnify or read out loud … yet. 
http://www.amazon.com/Kindle-Amazons-Wireless-Reading-
Device/dp/B000FI73MA 
http://talkingbookslibrarian.blogspot.com/2007/11/amazon-
announces-kindle-wireless.html 
 
Cybook Gen3 is the European Kindle 
http://www.bookeen.com/ebook/ebook-reading-device.aspx 
 
iRex iLiad is a larger Kindle. Loads from your desktop. 
http://www.irextechnologies.com/products/iliad 
http://en.wikipedia.org/wiki/ILiad_(E-book_Reader) 
http://www.youtube.com/watch?v=UdlPHxPNw-Y 
 
Return to Index 
 
 

 18

http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.humanware.com/en-usa/products/dtb_players/compact_models/_details/id_81/victorreader_stream.html
http://www.apple.com/ipodtouch/
http://www.apple.com/webapps/index.html
http://www.amazon.com/Kindle-Amazons-Wireless-Reading-Device/dp/B000FI73MA
http://www.amazon.com/Kindle-Amazons-Wireless-Reading-Device/dp/B000FI73MA
http://talkingbookslibrarian.blogspot.com/2007/11/amazon-announces-kindle-wireless.html
http://talkingbookslibrarian.blogspot.com/2007/11/amazon-announces-kindle-wireless.html
http://www.bookeen.com/ebook/ebook-reading-device.aspx
http://www.irextechnologies.com/products/iliad
http://en.wikipedia.org/wiki/ILiad_(E-book_Reader)
http://www.youtube.com/watch?v=UdlPHxPNw-Y


  Assistive Technology  

 
Magnifiers, Electronic, Hand Held 
 

DinoView portable 
http://www.independentliving.com/prodinfo.asp?number=45465
8 
 
Optelec Compact+ portable 
http://www.optelec.com/us_en/index.php/products/electronic-
low-vision/compact-plus/ 
 
Amigo 
http://www.ulva.com/Online-Store/Video-Magnifiers/amigo.htm 
http://www.enhancedvision.com/products/low_vision_assistive_
devices.php 
 
Opal by Freedom Scientific 
http://www.accessibility.net/store/Handheld_Magnifiers.html 
 
Nemo 
http://www.ulva.com/Online-Store/Video-Magnifiers/nemo.htm 
 
Smartview Series - 4 new electronic magnifiers from Humanware 
http://www.humanware.com/en-
usa/products/low_vision/smartview 
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The QuickLook video magnifier 
http://www.jbliss.com/quicklook.htm 
 
Return to Index 

 
Magnifiers, Electronic, Desktop (CCTV) 
 

Topaz by Freedom Scientific 
http://www.accessibility.net/store/CCTV.html 
 
Smartview Extend by Humanware 
http://www.accessibility.net/store/CCTV.html 
http://www.humanware.com/en-usa/products/low_vision 
 
Jordy Head mounted CCTV 
http://www.nanopac.com/Jordy.htm 
 
Optelec ClearNote+ desktop 
http://www.optelec.com/us_en/index.php/products/electronic-
low-vision/clearnote/ 
 
 
 
Onyx by Freedom Scientific 
http://www.freedomscientific.com/products/lv/onyx-main-
product-page.asp 
http://www.granteyeglasses.com/onyx.html 
 
Merlin CCTV 
http://www.enhancedvision.com/downloads/MerlinPlusSpecs.pdf 
 
Magnicam works with your TV 
http://www.magnicam.com/ 
 
 
Return to Index 
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Magnifiers, Software for Computer Screen 
Commercial Computer Magnifiers 

 
Magic by Freedom Scientific, with or without speech 
http://www.freedomscientific.com/PDF/lowvision/flyers/MAGicFly
er.pdf 
 
ZoomText by Ai Squared, with or without speech 
http://www.aisquared.com/index.cfm 
 
Lunar & Lunar Plus by Dolphin 
http://www.yourdolphin.com/productdetail.asp?id=3 

 
Free & Low Cost Computer Magnifiers 

Asstd Screen Magnifiers: free, shareware & professional. 
Magnification should also do Text Smoothing. Many have jagged 
edges on the font. Some are not stable. 

• http://www.magnifiers.org/links/Download_Software/Scree
n_Magnifiers/ 

• http://www.bluechillies.com/query.php?text=IE%Magnifier
&page=1 

 
Magic Lens Max 

• Customizable lens shape with 3 smooth styles (Ellipse, 
Rounded Rectangle and Rectangle)  

• Variable magnification from 1/2x to 32x  
 http://www.visionsuit.com/index.html 
 
Dragnifier magnifies mouse area 
http://www.halley.cc/stuff/dragnifier.html 
 
Screen Loupe 
http://www.gregorybraun.com/Loupe.html 
 
ZoomWare, by AISquared, improves screen magnification, 
contrast & color 
http://www.getzoomware.com/videos 
 
Return to Index 
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Magnifiers for the Web Browser 
 
 Magnifiers for Internet Explorer 
 
 Go to manufacturers web site for Zoom Text & for Dolphin’s Hal 
 Screen Reader or Supernova Reader Magnifier. 
 
 Browser Buddy 
 http://www.bluechillies.com/details/8918.html 
 
 ProSurf 
 http://www.bluechillies.com/details/10133.html 
 
 Hyperjoint Zoom Buttons 
 http://www.bluechillies.com/download/8128.html 
 
 Big.Com free magnifier for Internet Explorer 

http://download.nytimes.com/Big-com-Web-Magnifier/9100-
12777_4-10515888.html?tag=lst-0-3 

 
Firefox Browser Add-ons 

 
No Squint for FireFox Browser 
https://addons.mozilla.org/en-US/firefox/addon/2592 
A FireFox browser add-on. It allows you to adjust the default text zoom level for any site - and 
then remembers it on a per-site basis. 

 
Low Browse – free Firefox add-on developed by Lighthouse 
International 
http://lighthouse.org/aboutus/press/press-releases/lowbrowse 

 
Low Vision Web Browsers 

 
Opera Browser adapts for low vision 
Built-in magnifier, adaptable menues, etc. 
http://us.geocities.com/tim_hobbs.geo/opb.htm 
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Mozilla Firefox Browser does too. 
http://www.mozilla.org/ 
 
Web Eyes – Add-on for Internet Explorer 
http://www.ionwebeyes.com/ 
 
Tips for Browser setup 
http://www.alistapart.com/articles/lowvision/ 
http://63.240.118.132/Section.asp?DocumentID=1452&SectionI
D=4 
 
Connect Outloud by Freedom Scientific 
http://www.freedomscientific.com/fs_products/software_connect
.asp 
 
Fire Vox – a screen reader add-on for the FireFox browser 
http://www.firevox.clcworld.net/features.html 
 
Web Visum –helpful add-ons for Firefox browser 
http://www.webvisum.com/ 
 
 
WebLV adds the Internet & email to CCTV 
http://www.jbliss.com/weblv.htm 
 
Webbie – Free Low Vision Browser 
http://www.webbie.org.uk/ 
 
IBM Home Page Reader – Talking web browser 
http://www-03.ibm.com/able/news/hpr_enduser.html 
 
Browsealoud – free software for PC & Mac that reads text 
selected by mouse on compatible websites. Mostly in UK. 
http://www.browsealoud.com/page.asp?pg_id=80004 
 
Accessible Google 
In order to help the visually impaired find the most relevant, useful information on the 
web, and as quickly as possible, Google developed Accessible Search. Google 
Accessible Search identifies and prioritizes search results that are more easily used by 
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blind and visually impaired users – that means pages that are clean and simple (think 
of the Google homepage!) and that can load without images. 
http://labs.google.com/accessible/ 
 
 
Return to Index 

 
 
Magnifiers for the Mac 
 Text magnification is built into the Mac operating system. 
 
 Coloristic - Simple magnifier utility, that magnifies the area   
 around the mouse cursor. Also for Windows XP. $12 
 http://www.bubblepop.com/coloristic/index.html 
 
 Lupe for Macintosh - from Artis Software, Lupe is a FREE 
 screen magnifier utility, that magnifies the area around the 
 mouse cursor from 2 to 8 times. ( 
 http://www.artissoftware.com/lupe.html 
 
 Macintosh Software Toolkit – freeware & shareware utilities  that 
 help sight impaired people accessing the Macintosh 

http://trace.wisc.edu/world/computer_access/mac/macshare.ht
ml 

 
Return to Index 
 

 
Text to Speech (TTS) Screen Readers, Software for Computers 
 Have your computer read to you. 
 
 BBC Screen Reader Testing Guidelines 

http://209.85.215.104/search?q=cache:WxmnUYWLDUUJ:www.
bbc.co.uk/guidelines/newmedia/accessibility/screenreader.shtml
+how+%22screen+reader%22+UK&hl=en&ct=clnk&cd=2&gl=u
s 
 
Comparison of Web-based Text to Speech programs. 
Info is helpful, but live links are not functional. 

 http://www.laits.utexas.edu/hebrew/personal/tts/table.html 
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Commercial Screen Readers for the Blind 

 
JAWS screen reader by Freedom Scientific 
http://www.freedomscientific.com/fs_products/software_jaws.asp 
http://en.wikipedia.org/wiki/JAWS_(screen_reader) 
 

 HAL by Dolphin 
 http://www.yourdolphin.com/productdetail.asp?id=5 
 
Commercial Screen Readers for Low Vision 
 

Magic by Freedom Scientific, with JAWS speech 
http://www.freedomscientific.com/PDF/lowvision/flyers/MAGicFly
er.pdf 
 
ZoomText Reader by Ai Squared,  
http://www.aisquared.com/index.cfm 
 
Lunar Plus by Dolphin 
http://www.yourdolphin.com/productdetail.asp?id=3 
 
Window-Eyes screen reader by GWMicro 
http://www.gwmicro.com/Window-Eyes/ 
 
TextAloud screen readers by Nextup 
Uses Acapela voices 
http://www.nextup.com/products.html 
 
Infovox Desktop  for Windows – screen reader by Acapela 
http://www.acapela-group.com/infovox-desktop-for-windows-3-
speech-solutions.html 
 

Free & Low Cost Screen Readers for Low Vision 
Many of these are experimental. Proceed with caution. 
 
Text to Speech Shareware 
http://www.sharewareconnection.com/titles/speech-to-text.htm 
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SmartRead - Free Computer Screen Reader 
http://www.smartysoft.com/index.php 
 
Speech Synthesizer 5.0 
http://www.caltrox.com/products/speech.htm 
 
TextSpeech Pro for PCs by Digital  Future 
http://www.textspeechpro.com/download.html 
 
Free Text to Speech software by Dimio’s Tools 
http://dimio.altervista.org/eng/ 
 
Help Read - a free text reader 
http://www.pixi.com/~reader1/allbrowser/ 
 
Read Please & Read Please Plus 
http://www.readplease.com/english/readplease.php 
 
Say Pad text to speech also can create Text to Audio MP3 files 
http://www.afreego.com/Categories/Multimedia/MP3/006712.ph
p 
 
Read to Me text to speech reader 
http://download.nytimes.com/Read-to-Me-Text-To-
Speech/9100-7239_4-10702544.html?tag=lst-0-2 
 
Verbose Text to Speech Converter 
http://www.nch.com.au/verbose/index.html 

 
NVDA - NonVisual Desktop Access (NVDA) is a free and open source screen reader for the 
Microsoft Windows operating system. 
http://www.nvda-project.org/ 
 
Talklets by Textic Textic, the company behind Talklets, has developed breakthrough 
technology for turning web content into speech. 
http://www.textic.com/index.html 
http://assistivetek.blogspot.com/ 
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Text to Speech conversion is built into Microsoft Word. 
1) Choose Speech in the Tools menu 
2) Select Speak in the floating Speech toolbar 
3) If “Speak” is not visible, click on small down arrow at end 

of Speech toolbar & select. 
 
Text to Speech conversion is built into Adobe Acrobat Reader 
8.0 and later: 
1) Set up in Edit > Preferences > Reading > Read Out Loud 
 Options. 
2) Activate in View > Read Out Loud > Activate 
 

 Text to Speech is built into the Mac Leopard OS X 
 Cmd-F5 starts Voice Over 
 
Talking Dictionary on your computer 
 http://benolsatuem.com/2008/07/talking-dictionary-710.html 
 
WebAnywhere … web-based screen reader for the web. 
 Online text to speech reader runs on Internet. 
 Still under development. 

• http://www.networkworld.com/community/node/29310 
• http://webinsight.cs.washington.edu/papers/webanywhere-

html/ 
• http://webanywhere.cs.washington.edu/ 
• http://www.eschoolnews.com/news/top-

news/?i=54514;_hbguid=1acccdf1-82d9-4583-bdf2-
efcf294c5f81&d=top-news 

• http://www.msnbc.msn.com/id/25630182/page/2/ 
 

 Odiogo - It transforms news sites and blog posts into high fidelity, near human quality 
audio files ready to download and play anywhere, anytime, on any device, MP3 or iPod. 

http://www.odiogo.com/ 
 
 Menus That Talk – a service available at some restaurants 
 http://www.menusthattalk.com/products.html 
 

Return to Index 
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Scan to Speech Conversion: 
 Converts a physical book to speech. 

 
Daisy EasyReader 
www.yourdolphin.com 
 
OpenBook 
http://www.freedomscientific.com/products/fs/openbook-
product-page.asp 
 
SARA 
http://www.freedomscientific.com/products/lv/sara-product-
page.asp 
 
Kurzweil 3000 Professional 
http://www.kurzweiledu.com/kurz3000.aspx#q1 
 
KNFB Reader on a cell phone 

• http://www.knfbreader.com/ 
• http://gizmodo.com/349558/kurzweil-develops-first-

seeing+eye-cellphone 
 

Zoom-Ex is a fast, packaged, light weight scan to speech unit. 
It folds up and fits in your laptop bag. Runs on any Windows-
based computer or laptop. 

 http://www.zoom-ex.com/html/zoomex_products_zoom_ex.htm 
Review & prices for Zoom-Ex in Vision Access Magazine, Vol. 14, 
No. 4, Page 43. 
http://www.cclvi.org/vaccess/main.htm 

 
An inexpensive alternative approach is to scan the document on 
any scanner. Buy one that can scan bound books. This first step 
just makes a picture of the document. Then run it thru OCR 
software such as IRIS, Kurzweil 1000 or FineReader, converting 
it to real text. Then read that file out loud with a screen reader. 

 
 

Return to Index 
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Speech to Text Conversion, Speech Recognition 
 The computer types what you speak. 
 Enter computer commands verbally. 

 
Dragon Naturally Speaking Speech Recognition Software 9.0+ 

• Speak rather than type.  
• Spell correctly every time. 
• Move around your document, format paragraphs, and even 

move your mouse by voice. 
http://www.nuance.com/naturallyspeaking/ 
 
MacSpeech Speech Recognition for Macintoshes 
http://www.macspeech.com/pages.php?cID=4&pID=24 
 
 
Microsoft Speech Recognition 
Part of the MS Word Speech Toolbar 
Must be taught to recognize your speech. 
 
Return to Index 
 
 
 
 

  The Apple Macintosh & its Special Strengths 
 
The Apple Macintosh has an excellent set of 
assistives built into the operating system. It 
is capable of text magnification and text to 
speech conversion without additional 
software. 
 
Apple’s commitment to accessibility is 
evident throughout the Mac OS X operating 
system, which is not only easy to use by 
design, but also includes a wide variety of 
features and technologies specifically 
designed to provide access to users with 
disabilities. Apple refers to these features 
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collectively as Universal Access and has integrated them into 
the operating system so they can be used in conjunction with a 
variety of applications from Apple and other developers. Apple is 
also changing the ways people interact with technology through 
innovative products like the iPhone, which bring new possibilities 
for making user interfaces accessible to users with disabilities. 

The new features in Universal Access.  

http://www.apple.com/macosx/features/300.html#universalacce
ss 

Accessibility Technologies in Mac OS X 

 Zoom  
 Full keyboard navigation  
 Sticky Keys and Slow Keys  
 Mouse Keys  
 Closed-Captioning in QuickTime  
 Visual alert  
 Spoken items  
 Talking alerts  
 Speech recognition  
 Display adjustment  

Simple computer keystrokes to control your Macintosh: 
 

Universal Access and VoiceOver 

Keyboard 
shortcut 

Description 

Option-Command-
8 

Turn on Zoom 

Option-Command-
+ (plus) 

Zoom in 

Option-Command-- 
(minus) 

Zoom out 

Control-Option-
Command-8 

Switch to White on Black 

Control-F1 Turn on Full Keyboard Access 
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When Full Keyboard Access is turned on, 
you can use the key combinations listed in 
the table below from the Finder. 

Control-F2 
Full Keyboard Access 
     Highlight Menu 

Control-F3 
Full Keyboard Access 
     Highlight Dock 

Control-F4 
Full Keyboard Access 
     Highlight Window (active) or next 
window behind it 

Control-F5 
Full Keyboard Access 
     Highlight Toolbar 

Control-F6 
Full Keyboard Access 
     Highlight Utility window (palette) 

Command-F5 or fn-
Command-F5 

Turn VoiceOver on or off (Mac OS X 10.4 
or later) 

Control-Option-F8 
or fn-Control-
Option-F8 

Open VoiceOver Utility (Mac OS X 10.4 or 
later) 

Control-Option-F7 
or fn-Control-
option-F7 

Display VoiceOver menu (Mac OS X 10.4 or 
later) 

Control-Option-;  
or fn-Control-
option-; 

Enable/disable VoiceOver Control-Option 
lock (Mac OS X 10.4 or later) 

  The Universal Access preference pane allows you to turn on 
Mouse Keys. When Mouse Keys is on, you can use the numeric 
keypad to move the mouse.  

 

Return to Index 
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Text to Speech Screen Readers for Macintoshes 
 

Mac Text to Speech Synthesis 
http://www.apple.com/education/accessibility/technology/text_t
o_speech.html 
 
TextSpeech Pro for Macs by Digital  Future 
http://www.digitalfuturesoft.com/texttospeechproductsformacos
x.php 

 
Speech Recognition for Macs 

You speak into a microphone & the computer obeys the 
command or types a document. 
 
Comparison 
http://speechwiki.org/out-loud/mac.html 
 
Instructional Video 
http://lifehacker.com/software/speech-recognition/hack-attack-
make-your-macs-speech-recognition-work-for-you-215764.php 
 
MacSpeech Dictate  
http://www.macspeech.com/ 
 
Return to Index 

 
 
 
  Financial Aid for Assistive Technology 
 

There are a lot of sites, but very little funding available. 
Not covered by Medicare. 
 
ICDRI Advice 
http://www.icdri.org/Finance.htm 
 
US Dept of Health Advice. See page 3. 
http://www.aoa.gov/press/fact/pdf/fs_assitive_tech.pdf 
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Eldercare Locator 
http://www.eldercare.gov/Eldercare/Public/resources/fact_sheet
s/assistive_tech.asp 
 
NC State Financial Assistance Advice 
http://www.ncatp.org/Funding/Funding%20to%20Individuals.ht
ml 
 
New Freedoms Initiative Bill before Congress May 2008 
http://usgovinfo.about.com/library/weekly/aa020201b.htm 
 
Assoc of Blind Citizens AT Fund 
http://www.blindcitizens.org/assistive_tech.htm 
 
Postage Free Mail for the Visually Handicapped 
http://www.usps.com/cpim/ftp/pubs/pub347.pdf 
 
The New Fund – low interest loans for disabled Virginians 
http://www.atlfa.org/ 
 
 
Return to Index 
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Websites with Useful Advice for the                
 Visually Challenged 
 
How Can I Organize My Kitchen To Find Things 
More Easily? 
http://www.visionaware.org/how_can_i_organiz
e_my_kitchen_to_find_things_more_easily 
 
Useful Home Adaptations for The Blind and 
Visually Impaired 
http://www.lowvision.com/tips/useful-home-
adaptations-for-the-blind-and-visually-
impaired/ 
 
Adapting To Reduced Vision From Age-Related 
Macular Degeneration 
http://www.cigna.com/healthinfo/rt1271.html 
 
Online Lessons on Living Better at Home 
http://www.lighthouse.org/livingbetter/ 
 
How to Find a Dropped Object 
http://www.visionaware.org/locating-dropped-
objects 
 
Videos about Low Vision 

• http://video.google.com/videosearch?q=%
22low+vision%22&sitesearch=# 

• http://uk.youtube.com/watch?v=fw91hsVr
f40 

• http://www.webmd.com/video/tips-for-
better-vision 
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• http://www.videojug.com/film/how-to-
cope-with-sight-loss-2 

• http://www.eyecareamerica.org/eyecare/c
onditions/low-vision/video.cfm 

 
Low Vision Simulation to show your family 

• http://www.lowvisionsimulationkit.com/pro
ducts.html 

• http://www.lowvisiononline.unimelb.edu.a
u/LowVision/LowVision_simulation.htm 
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